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1. Testing PTP

@ Synchronisation Source

|

1.1 Connecting Paragon-X for Testing

10GbE Port 1 10GbE Port 2 Status Display

=

Be a
| h—

Aux  100MbE/1GbE 100MbE/1GbE PC Controller usB
Ports Port1 Port 2 Port Port

The Paragon-X front panel provides the following interfaces:

e 100MbE electrical or optical (SGMII SFP)
e 1GbE electrical or optical (SFP) — with option 110 fitted
e 10GbE optical (XFP or SFP+) — with option 111 fitted

In earlier versions, the USB port is not enabled. In later versions, it can be used to supply power to the Option 133 External
1pps/ToD Frequency Converter accessory.

NOTE: When using optical connectivity, SFP/SFP+/XFP modules must be inserted into both ports on Paragon-X to enable
their selection in the Setup Interface - Ethernet window in the Paragon-X Graphical User Interface (GUI)..

To enable measurement of the PTP performance of a device-under-test (DUT):

1. Connect the PTP Slave Clock port of the DUT to port 1 of Paragon-X
2. Connect the PTP Master Clock port of the DUT to port 2 of Paragon-X



1.2 Connecting a Reference Clock to Paragon-X

The Paragon-X rear panel provides the following reference and measurement inputs:

Earler Versions

12 13

®

e

Later Versions

15

10 — DC Power Input

11 — Power Switch

12 — 1pps Reference Input

13 — Wander Measurement Inputs
e 2.048MHz (BNC)
e E1(2.048Mb/s) balanced (Bantam) or unbalanced (BNC)
e DS1(T1) (1.544Mb/s) balanced (Bantam)

14 — Reference Inputs
¢ 10MHz (BNC)
e 2.048MHz (BNC)
e E1(2.048Mb/s) balanced (Bantam) or unbalanced (BNC)
e DS1(T1) (1.544Mb/s) balanced (Bantam)

15 — Reset Switch

16 — 64K AMI Reference Input

17 — GPS Reference

18 — GPS Antenna Input (currently unused)

Connect the common synchronisation reference to the relevant reference input. If required, connect the common 1pps
reference or Master Clock 1pps reference output to the appropriate Paragon-X 1pps reference input (12 or 17 depending on
cable and connector type).



2. Application Setup

2.1 Configuring Paragon-X for PTP (1588v2) measurements

1. Verify that physical connections have been made as described above.

2. From your Windows PC, start the Paragon-X client (GUI) by clicking Start > All Programs > Calnex/Paragon-X (different

Windows operating systems may vary slightly).

3. Onthe Paragon-X GUI, press Start Up and connect to the Paragon-X (see the Getting Started Guide for more details if

required).

4. Click on the Operating Mode button then enable 1588v2 > Enable Master/Slave Emulation.

File Instrument(s) Setup Capture Impair Graph Data Tools Help

EL @oo gerEEL o oo e

Start Up

’ Operating Mode

Setup Interface

MasterfSlave/GPS
Emulation

Measurements
Select Flow
Configure Capture

Start Capture

Add Impairments/
Delay

Filter

@ 1588v2
/| Enable Master Slave Emulation
Services
SyncE
NTP
Ethernet OAM (802.1ag, ¥.1731)
MPLS-TP OAM (PTN based on Y.1731)

8902

Close

5. Select the Setup Interface button nd ensure the appropriate line rate and interface are configured.

Note: if using SFP, SFP+ or XFP modules, the transceivers must be inserted into both Ports 1 and 2 of Paragon-X to allow

their selection.

Setup Interface

Ethernet References MeasurementPorts  ToD

(®) Tx+Rx Mode Thru Mode .t_)u

SyncE ClockRx -> Tx @@

Coupled
Port 1 Port 2
Line Rate Line Rate
(O 100MeE  @1ekE (O 10GbE 100MbE
Interface Interface
@RM5 | SFR/SFP+ e @ R145
|:| Auto Megotiate Auto Negotiate
GbE Electrical Phy Settings
O Force Port 1 Port 2
(@Master () Slave (@ Master () Slave
(@ preferred

1GbE 10GbE

SFRSFP+ (L %FP @D

Close




6. Select the References tab, then configure the appropriate reference sources e.g.

Setup Interface

Ethernet References Measurement Ports  ToD

Clock Source
Ext. BNC Ext. Bantam
10MHz T1 ternar
(O Internal © O v
(JE1/ 2.048MHz (D E1 ternary
ipps Reference Input
®BNC (O GPS D-type O Internal
.:ﬁ]
High Impedance 50 Ohm t_"

External Wander Generation

Enable Wander Clock Source:

Reference Output {Lower Front Aux Port)

®1wmHz O ipps i
1pps width: 0

s

X

Ext. D-type
(Ci64kb/s

Start MSE Master
using 1pps Ref

Master 1

Master 2

T1wander meas Bantam

(Range: 1 to 500,000 ps)

7.
File Instrument(s) Setup Capture Impair Graph Data Tools
EL seoo ZEEL 2~ c e

Start Up

Operating Mode

Setup Interface

Master{Slave/GPS
Emulation

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments}
Delay

Add YWander

8. Click on the Close button.

If measuring recovered frequency, select the Measurements button then select the appropriate measurement e.g.

Help

Configuration

/| Simultaneous Measurements and Impairments/Delay

Measurements

Sync-E Wander

Time of day

MNone
T1 Wander
@ E1Wander
2,048 MHz Wander

MNone
'@ 1pps Time Error{Absolute)
1pps Time Error{Relative)




9. Check Port 1and Port 2 Link and Good Pkts, Ref lock and Wander Lock (if carrying out a E1/T1/2.048MHz wander

measurement) are showing as green. Wander is red in the example below to indicate no Wander measurement signal is
detected.

Yellow indicators mean that a status has changed from bad to good, so if any are yellow, click Reset History and confirm
they go green.

2.2 Setting Filters to Capture/Replay the 1588v2 Flow

The Paragon-X uses a tool called “Flow Wizard” to select the 1588v2 flows and set the filters to target these flows.

1. Click on Select Flow and the following window will appear:

Start Up

Setup Interface l;_. Capture Packets

E o yhizard
. Wireshark

Measurements

Select Flow

Configure Capture

2. Click on the Capture Packets button to start the capture.

3. After a short time (approximately 10 Seconds) click on the Stop Capture button.

. Stop Capture

E Flow Wizard

. Wireshark
b11110111

b

Select Flow

b
b
b
b
b




4. Click on Flow Wizard and the following screen is displayed:

P = k i
The following flows were detected:
1588 | —

Protocols I I [ Ethetype [ 1588
e cthethertype:ptp  01:1b:15:00:00:00 d0:00:00:00:00:01 Type: PTPvZ ov DEL-REQ

Groups
’7 Group offlows || Expanded group of flows

5. Flow Wizard will automatically group flows that have the same value for each of the fields displayed. To show the
individual messages, right click on a pink row and then click “Expand row to show individual message types”.

— 1588 — — - — Al flows

Protocols Eth dst Eth src Ethertype IP src IP dst UDP =rc UDP dst 1588 message
— 22401.129

p— 22401.129

M cthethetypedip:... 01:00:5e:00:01:81 a0:00:00:00:00:01 Type: IPv4 (0. 1521684100 @ 22401125 35 35 SYNC
=e‘th ethertypeip:... 01:00:5e:00:01:81 d0:00:00:00:00:01 Type: IPv4 (0. 1521684101 22401.129 315 318 DEL-REQ

6. Select the flows of interest. Multiple flows can be selected by using either the “Shift” and left mouse button or “Ctrl” and
left mouse button. For example, to select SYNC, DEL-RESP and DEL-REQ messages, select the first message row then
Ctrl-click the second and third message rows. All the messages selected will be highlighted in blue, as shown below.

— 1588 — — — — All flows
Protocaols Eth dst Eth src Ethertype IP srz IP dst UDPse  UDPdst 1588 message
e cthiethertypesip:..  01:00:5e:00:01:81 a0:00:00:00:00:01 Type: IPwd (0. 1521684100 22401129 320 DEL-RESP

22401.129

e cthiethetypedip:...  01:00:5e:00:01:81 a0:00:00:00:00.01 Type: IPvd (IeD... 1521684100  224.0.1.129% 315 SYNC

ethoethertypeip:... 01:00:52:00:01:81 d0:00:00:00:00:01 Type: IPvd (x0... 152.168.4.101 224.0.1.129 319 DEL-REQ

7. Click to set the Filters and then to close the window.
8. Click to close the Select Flow window.

9. The Flow Filter window in the main Paragon-X GUI will now show that filters have been set.




2.3 Settings for IEEE1588

1. Click on the Configure Capture button then select the 1588 tab:

Configure Capture X

Timing Control ~ ToD 1588
Clock Mode:

(® 1 step dock (Sync) (0 2 step dock {Sync+Follow Up)

Delay Timing Measurements

[Jindude CorrectionField in Delay Calculation

Structure

1588 Packet Rate Packets/s

Absolute Time Locking

Start capture at Top of Second of ipps Reference Input (if prezent) 'Z(:l"
5 [}
5 [i]
ESMC Monitoring

Hport 1-»Port2  [JPort2-»Port 1

Close

2. Select either 1 step clock (Sync) or 2 step clock (Sync + Follow_Up) mode depending on the DUT mode to be tested.

3. Tick the box if the CorrectionField value contained in the Sync message is to be included in the calculation of the
captured PDV.

4. Enter the 1588 Packet rate. This is used if captured data is exported to Microsemi TimeMonitor.

2.4 Capturing IEEE1588 Header and Timing Information

1. Click on the Start Capture button. The Timing Header and directional information for each message will be displayed in
the table and the graph will show the combined inter-packet arrival time. The table continues to update in real-time with
the captured bi-directional 1588v2 messages.
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2. The graph can show 1588, SyncE or E1/T1 data (as available depending on test configuration). The displayed data can

be selected by using the option at the bottom right corner of the graph to display a menu of options:

Graph Display Mode

Inter-packet Arrival Time vs Tirme Aurto Graph Refresh 3
Inter-packet Arrival Time ws Packet # Auto ¥-dxis Scaling 3
ESMRAC T Quality ws Time: Porkl T Graph Format 4

ESMAC Rex Quality ws Tirne: Portl Rx

ESMAC T Quality ws Tirne: Portd T

POV Graphs - 1582
ESMC Fox Quality ws Time: Port2 R ey 2 Eepplr b

Lock Graphs »
Plot PDFACDFHistograrm

Plot 1588 Clock Class

Calnex &nalysis Tool (1588w2)

Tirne Format +

3. Click on the Stop Capture button to stop the capture.

4. By default the Paragon shows all the fields in a 1588 message header. By using the Data — Column Organiser menu
option, it is possible to display only those of interest by ticking or unticking each option:

Column Organiser it

Select columns to show fhide

FlPort - Order

[Packet

[ Arrival Time +
[]Inter-Packet Time
[ZIESMC Quality: Port1 Rx +
[]Inter-Message Time
[~]messageType

[] transportSpedfic Reset
[]versionPTR
[“Imessagelength
[«]domainNumber
[ flags

[] correctionField Show Al
[]sourcePortidentity
sequenceId

| I T

W Hide All

o] o]




3. Analyzing an IEEE1588 Capture

Paragon-X offers a number of ways to evaluate captured data. This section gives a brief introduction and explanation of
some of these methods.

3.1 Analysing for mis-ordered, missing and repeated messages

1. The header and timing table allows the user to quickly determine if there are any mis-ordered, missing or repeated
packets. An icon at the top of the SequencelD column will indicate this:

‘/ E:E!Iql_JErII::Ellj Indicates no error

Indicates an error has occurred

2. To view to the first/next error use the ##l icon in the menu bar, and the first/next error row will be displayed at the top

of the table. Errors are identified by the following 1588 message row being highlighted in red, so it may be be necessary
to scroll up to determine the missing row.

In the screenshot below the DEL-REQ with sequenceld 706 has no corresponding DEL-RESP message from the Master
Clock. The next DEL-RESP message (with sequenceld 707) is highlighted in red to show the previous one is missing.

Note: The number of columns displayed in this image has been reduced from the default for clarity by using the Column
Organiser option described in point (4) of the previous section.

34 icon.

3. To view the previous error use the
3.2 Analysing captured messages by using the graphs

Paragon-X offers extensive graphing facilities to analyse the 1588 Master Clock — Slave Clock timing

1. To access the graph options click to display a menu:

Graph Display Mode »
Auto Graph Refresh 3
Auto ¥-Axis Scaling 3
Graph Format ]
Time Format ]
Show 2nd Graph -]
Lock Graphs ¥

Open in New Window

Plot PDR/CDF/Histogram
Plot 1588 Clock Class
Calnex Analysis Tool (1588v2) b

1



Graph Display Mode — Access to the different graphs for analysis:

Menu option

Description

PDV Graphs — 1588

Sync PDV

Slave Wander
Pdelay_Req PDV
Pdelay_Resp PDV
Follow_Up PDV
Delay_Resp RTD
Delay_Req PDV
Round Trip PDV

Inter-packet Arrival Time vs Time

Displays the Inter-packet arrival time for a

S

pecific message against time.
Sync
Delay_Req
Pdelay_Req
Pdelay_Resp
Follow_Up
Delay_Resp

Inter-packet Arrival Time vs Packet #

Displays the Inter-packet arrival time

a

gainst packet number.

o Auto Graph Refresh — Graph refreshes approximately every 10 seconds.

e Graph Format — Choose between line or dot graph format (upper and lower images, respectively):

861490

I' \\ H ' | V i

e Show 2™ Graph — A second graph is displayed of the same data which can be configured independently of the first.

\( i “ M ‘[ ‘ii |'4'| ﬁ “‘ {I ” H“‘ ’\ Iu” \\‘}} \‘.h

e Lock Graphs — If two graphs are displayed and showing the same data, selecting On links their x-axis so that both are

aligned.

e Open in New Window — Opens another graph in a new window which can be configured independently of any others.

12



3.3 Description of PDV graphs

A description of each graph with examples is provided on the following pages. Note that all PDV graphs show the variation
between values and not absolute values, and Paragon-X must be situated next to the Slave Clock and locked to the Master
Clock’s clock reference.

Sync PDV (1 step)

The Paragon-X uses the arrival time of the Sync message at the Paragon-X and the timestamp from the Sync message to
calculate Sync PDV.

0.01045157

DE, !
iAY,_,F\)ESP Mes
Sage Sync PDV - Example of a Live Capture

time

Propagation Delay
Message Exchange

v

Sync PDV (2 step)

The Paragon-X uses the arrival time of the Sync message at the Paragon-X and the timestamp from the Follow-Up message
to calculate Sync PDV. Note: 2 step clock needs to be selected in the 1588 Settings as previously described.

Graph C:

) * "N \v 'f M ‘ W j | MM 'l ,W

_+ W il

time

Propagation Delay
Message Exchange Sync PDV — Example of a Live Capture

13



Follow_Up PDV

The Paragon-X graphs the variation in arrival time of the Follow_Up message with respect to the Sync message as shown
below:

Graph Context:
CAF'TUF\E 158842

tarkers

Propagation Delay
Message Exchange

Follow_Up PDV - Example of a Live Capture

Slave Clock Wander

The Paragon-X extracts the embedded timestamp within the Delay_Req message and compares it to the Master Reference,
the variation is then graphed to provide the Slave Wander output as shown below:

CAPTURE - 1588v2 B

Mtz

T

\H

|

Der
AY_Resp essa
—~90e

time

Propagation Delay
Message Exchange

v

v

Slave Wander — Example of a Live Capture
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Delay_Resp Round Trip Delay (RTD)

The Paragon-X calculates and graphs the time difference between the arrival time of the Delay_Req message and the
corresponding Delay_Resp message as shown below:

time

Propagation Delay
Message Exchange

Delay_Resp Round Trip Delay (RTD) — Example of a Live Capture

Delay_Req PDV

The Paragon graphs the variation between the launch time (arrival time at the Paragon) of the Delay_Req message and the
embedded timestamp, t4, in the Delay_Resp message as shown below:

time

Propagation Delay
Message Exchange

Delay_Req PDV — Example of a Live Capture

15



Round Trip Delay
The Paragon graphs the variation in (t2 — t1) + (t4 — t3) Round Trip Delay i.e. the calculation performed by the Slave as
shown below:

Propagation Delay ¥

Message Exchange
Round Trip Delay — Example of a Live Capture

3.4 Description of Inter-packet Arrival Time vs Time Graphs
For each of the 1588 messages it is possible to graph the Inter-packet arrival time versus time. This will allow you to have

enhanced visibility of the 1588 network by determining if the messages are arriving at regular intervals and/or if they are
being delayed by the network, Master Clock or Slave Clock.

Sync IPG

16



Delay_Resp IPG

3.5 Using the Graph Zoom function
1. To zoom into a particular part of the graph, click and drag with the left mouse button to highlight the desired area. When

the button is released the display will zoom in to the highlighted section. Clicking on the graph area with the left mouse
button also zooms in, with the displayed view centred around the click location.

2. ltis also possible to zoom the graph in both the X- and Y- axis around the graph centre by using the buttons.

The full capture A partial view
is being displayed of the full capture
is being displayed

4. To zoom out, click the displayed graph area using the right mouse button.

3.6 Using the Graph Marker function

1. There are two markers that can be accessed from buttons:

These allow measurement on the graph by either using the mouse to click on the graph directly or by manually entering
values.

Set matker using rmouse

Enter rmarker manually

Clear marker

17



2. Data relating to the placed markers and displayed data is shown at the top of the graph:

3. <Ctrl>-click left mouse button on a packet within the graph will bring that packet to the top of the table above the graph,
allowing inspection of its properties.

3.7 Analysing E1/2.048MHz/T1 wander from the recovered clock

1. If measurement of T1, E1 or 2.048MHz wander has been selected from the Measurements dialog, it is possible to view
the results in the displayed graph.

Measurements *

Configuration

[ simultaneous Measurements and Impairments/Delay

Measurements
[ syncE wander

Time of day

O Mone

(®) T1 Wander

() E1 Wander

() 2,048 MHz Wander

@ MNone
() 1pps Time Error{Absolute) Eﬁl
() 1pps Time Error{Relative) Eﬁl

Close

2. Select the desired capture from the Graph Context dropdown menu at the top right side of the graph area. Note that
only the option selected in the Measurements dialog will be available for selection:

Graph Contest: [araph Contest:

CAPTURE - 158582 w CAPTURE - 1588w2 ~

CAPTURE - 15882 CAPTURE - 15882
CAFTURE - E1/T1 CAPTURE - 2.048MHz

18



3. The E1/T1/2.048MHZ wander TIE graph will then be displayed:

-0.000 pprn

4. To measure against the MTIE/TDEV limit lines, click and then Calnex Analysis Tool (E1/T1).

Graph Display Mode

Auto Graph Refresh »
Auto Y-Axis Scaling »
Graph Format »
Time Format »
Show 2nd Graph »
Lock Graphs »

Open in New Window

Plot PDF/CDF/Histogram
Plot 1588 Clock Class
Calnex Analysis Tool (E1/T1)

Tk P

Snapshot currently selected data and send to Calnex
Analysis Tool

19



This will launch the Calnex Analysis Tool (CAT) which can be used to further analyse the captured data:

B AT - Calnex Analysis Tool v20.0 — O ®

Application ESTEEL]

TIE/ESMC Mask Status

Select File
No metrics with acfive masks

Select Metrics Metric Statistics

Mean [ns]

Min [ns]

Max [ns]

Max-Min [ns]

Rate 1.00/second

View Results

Generate Report

Export

Sample #

897.000
898000
899.000
900.000
901.000
902.000

903.000

Elapsed Time (s)

400
Elapsed Time [s]

Date / Time TIE (ns)

2011-06-17 09:50:54
2011-06-17 09:50:55
2011-06-17 09:50:56
2011-06-17 09:50:57
2011-06-17 09:50:58
2011-06-17 09:50:59

2011-06-17 09:51:00

oL DN

Markers Editor

‘Chart & Zoom mode

= 3

Visible Elements
i Errors [ Labels ¥ Markers

X-Axis Display Format:

Elapsed Time

Frequency Offset Removal

Chart Tools »

Marker 1 | Marker 2 | @

& Fit

Autohide Threshold & Stafistics

Save As Image

Masks

Parameters

Offset -0.0001 ppm

MTIE/TDEV masks can be viewed and selected from the Masks menu for each measurement type e.g.

E1 MTIE mask menu

No Mask

G.811 Wander Generation

G.812 Wander Generation Type |

G.812 Wander Generafion Type | + Temp
G.812 Wander Generation Type Il + Il
G.813 Holdover Transient SEC Op2
G.813 Wander Generation SEC Op1
G.813 Wander Generation SEC Op1 +Temp
G.813 Wander Generation SEC Op2
G.813 Wander Transient SEC Opt2
G.823 E1 PDH Sync Interface

G.824 T1 PRC Interface

G824 Trafiic Interface 1544

G.8261 Wander Limits EEC Op1
G.82611

G.8262 Wander Generafion EEC Op1
G.8262 Wander Generafion EEC Op1 +Temp
G.8262 Wander Generafion EEC Op2
G.8262 Wander Transient EEC Opt2
G.8263

G.8263 Variable Temp

G.8271.1 Network Limit

G.8272 PRTC

G.8272.1 ePRTC

G.8273 2 dTE Gen Const Temp

G.82732 dTE Gen Var Temp

G.8273 2 dTE Holdover Const Temp
G.8273 .2 dTE Holdover Var Temp
GR.1244 Wander Generation

E1 TDEV mask menu

|G_8262 Wander Generation EEC Op1 '~

No Mask

G.811 Wander Generation

G.812 Wander Generation Type |
G.812 Wander Generation Type Il + Il
G.813 Wander Generation SEC Op1
G.813 Wander Generation SEC Op2
G.813 Wander Transfer SEC Opi2
G.823 E1 PDH Sync Interface
G.823 E1 PRC Interface

G.823 E1 SEC Interface

G.823 E1 SSU Interface

G.224 T1 PDH Reference Interface

G.824 T1 PDH Reference Interface SEC Opf2

G.824 T1 PRC Interface

G.8261 Wander Limits EEC Op1
G.8261 Wander Limits EEC Op2
G.8262 Wander Generafion EEC Op1
G.8262 Wander Generafion EEC Op2
G.8262 Wander Transfer EEC Opi2
G.8272 PRTC

G.8272.1 ePRTC

G.8273 2 dTE Gen Const Temp
GR.1244 Wander Generation

E1TIE analysis

No Mask

G.812 Type | Long-Term Holdover Const Temp
G.812 Type Il Long-Term Holdover Const Temp
G.8262 11.1.1 Short-Term Phase Transient
G.8262 EEC-1 Long-Term Holdover

G.8262 EEC-2 Long-Term Holdover

G.8263 PEC-5-F Long-Term Holdover Const Temp

20



Paragon-X will then analyse the MTIE and TDEV data against the relevant masks and display a Pass/Fail indication.

B CAT - Calnex Analysis Tool v20.0 - O s

AT Application

TIE/ESMC ‘ MTIE ‘ TDEV | Mask Status

Select File

TEE1
. E1
Select Metrics MTIE E1

View Resuits 5=

'erm Holdover Const Temp Metric Statistics
Generate Report —
Min [ns]
Max [ns]
Max-Min [ns] 63
Rate 1.00/second

FollfcHICHE - S Pl

Export

Chart Tools
Markers Editor
Marker 1 | Marker 2 | W

Chart & Zoom mode
400
Elapsed Time [s] — &

% Fit
Elapsed Time (s) Date / Time Visible Elements
™ Errors & Labels 5§ Markers
7.000 2011-06-17 09:50:54 Autohide Threshold [ Staistics

898 000 2011-06-17 09:50°55 X Save As Image

899,000 2011-06-17 095056 e

Elapsed Time
900.000 2011-06-17 09:50:57
901.000 2011-06-17 09:50:58 Masks

902.000 2011-06-17 09:50:59

‘5.812 Type lil Long-Term Holdover ¢ ~
903.000 2011-06-17 09:51:00 -_—

Parameters "

B CAT - Calnex Analysis Tool v20.0 — O X
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3.8 Adding Impairments and Delays to IEEE1588 messages in Master Clock-Slave Clock Emulation mode

Del
Select il to display the impairment Configuration window. This allows configuration of various types of

packet delay and corruptions to be applied to the PTP packets flowing through Paragon-X in both directions. Multiple
impairments may be applied simultaneously by ticking the appropriate checkboxes for transmitted (Tx) and received (Rx)

packets.

<< Results

Selected Message Types
Master Tx: Sync, Del-Resp, Announce

Master Rx: Del-Reg

Configuration
Flow Filter

Master 1 Tx

Header Overwrite
Physical Corruption
Packet Corruption
Profile Corruption
Master Impairments

Master 1 Rx
Delay
Header Overwrite
Physical Corruption
Packet Corruption

Profile Corruption

oooooA

oooo®

| Mo File Imported.

Intrinsic Delay
Packet size: Small Packets (< 200 bytes)
Delay (ps): 6.7
Delay General Settings
Mode: Type: Apply to:
(O single (® Single flow (relative) (_) Packet sending time
(® Repeat (OMulti flow (O Correction field
Packet rate (Packets/s): (®) Both
Delay Insertion
Fixed delay (us): 0
Variable delay type:
Osantoath # of Packets:| 2000
Beating,F ~
Min ips):| 6,00
(0 step function
O Latency Max (us):| 1000600
O Constant #lpha:| 2.00000
O Gaussian
o Gamma EBeta:| 1.00000
(®) User defined Frro=is Ei:lzi ]
tin Mean Mz
Gaussian (Mormal) Distribution
Imported Profile

The Flow Filter dialog allows configuration of the Master Clock and Slave Clock device addresses and which message types

are to be impaired by entering the appropriate details and ticking or unticking checkboxes for each message type.

Selected Message Types
Master Tx: Sync, Del-Resp, Announce

Master R Del-Req

Configuration

Master 1 Tx
Delay
Header Overwrite
Physical Corruption
Packet Corruption
Profile Corruption
Master Impairments

Master 1 Rx
Delay
Header Overwrite
Physical Corruption
Packet Corruption
Profile Corruption

ooooo®

ooogs

Intrinsic Delay
Packet size: Smal Packets (< 200 bytes)
Delay (ps): 6.7

Flow Filter Editor

Messages:

192,168.4. 100

[IMultiple slaves: 0
192.168. 5. X

[syne

[CJFaliow-Up

[Delay Request
[“]Delay Response
[~]announce

[(signaling (from Master)
[Csignaling (from Slave)

Flow Filter Status

Flow Summary: Flow Detail:
Port 1Rx (Master)  Port 1 Tx (Master) IF Dest 224.0.1.128
DEL-REQ 000 UDP Source Port 319
0% ANNOUNCE UDP DestPort 319
ey DEL-RESP TP Message  DELREQ
a0 SYNC PTP Version
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Impairments are added by checking the appropriate boxes in the Master Clock 1 Tx and Master Clock 1 Rx lists, and then

configuring options as desired.

Note: if Header Overwrite is enabled, Physical Corruption and Packet Corruption cannot be selected as all three operate
at the physical layer.

Configuration
Flow Filter

Master 1 Tx
Delay
Physical Corruption
Packet Corruption

Profile Corruption

oooo®d

Master Impairments

Master 1 Rx

A

Delay

Header Overwrite
Physical Corruption
Packet Carruption

ooo

Profile Corruption

Note: Physical Corruption and Packet Corruption cannot be simultaneously applied.

Configuration
Flow Filter

Master 1 Tx
Delay O
Header Overwrite O
Packet Corruption O

Profile Corruption

od

Master Impairments

Master 1 Rx
Delay
Header Overwrite
Physical Corruption
Packet Corruption

Ooooos

Profile Corruption

Header Overwrite

Link Encapsulation:

Ethernet 1T ~

Service:

Raw Bytes ~

Format:
(@ Binary - = don't modify
O Hex v =invert

Distribution

Ethernet IT:
Data:

1(112)  bin
15(912) bin

Reset

Type:

(@) single

(OBurst of packets: | 1

OPercemage rate: | 0.00001

ORatio: 1 E- 7
OConant

Symbol rate: | 1

Physical Corruption

Periodicity:
@ Continuous

on for (g): | 0.1

Repeat for (s):

Type:
(®) symbol errors
(O Link flap

Distribution

Type:

®) single

(O Burst of packets: | 1

(C)Percentage rate: | 0.00001

ORahc: 1 |E-|7
OCaﬂsmnt

() Symbol rate: | 1

Periodicity:
@ Continuous

oOn for (g): | 0.1

Repeat for (g):
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Configuration
Flow Filter

Master 1 Tx
Delay O
Header Overwrite O
Physical Corruption [

| pacetCompion
Profile Corruption O
Master Impairments

O

Master 1 Rx
Delay
Header Overwrite
Physical Corruption
Packet Corruption

oooo®

Profile Corruption

Configuration
Flow Filter

Master 1 Tx
Delay O
Header Overwrite O
Physical Corruption ]
Packet Corruption O
O

Master Impairments

Master 1 Rx
Delay
Header Overwrite
Physical Corruption
Packet Corruption

O
O
O
O

Profile Corruption

Configuration
Flow Filter

Master 1 Tx
Delay
Header Overwrite
Physical Corruption
Packet Corruption

Profile Corruption

Master 1 Rx

Delay

Header Overwrite
Physical Corruption
Packet Carruption

Oooood

Profile Corruption

Packet Corruption

Type:

(®) Errored packet

(O Lost packet

(O Repeated packet

(O Misorder events to a depth: 1

Distribution
Type: Periodicity:
® Single (®) Continuous

(O Burst of packets: | 1

O Percentage rate: | 0.00001
O Ratio: 1 E- 7

O Constant

Symbol rate: | 1

(.1050 (Random) Profile Packet Loss

Onfor(s): 0.1

Repeat for (s): | 1.0

@ Marked packets will be dropped

(To activate: enable "Variable Delay Insertion' or Generate Profile)

Replay Mode: (()Single (@) Repeat

Mumber of samples:

Low Loss State

Packet drop probability (%): 0.0010000

State transition probabiiity (32): | 0.0000000

High Loss State

Packet drop probability (%4):
State transition probability (3%): | 85.0000000

Generate Profile

Time Adjustment

Jump time by: | seconds e

Header Corruption

|:| Invert two step setting
[Jinvert unicast flag

Signaling Impairments

Message Suppression

Grant Unicast Rates: Unaltered ~

Grant Duration (% of requested):

[ stop Announce messages for (g):
[I5top Sync/Follow-Up messages for (s):
[[I5top Del-Resp messages for (s):

[[]stop PDel-Req messages for (5):

[[]stop PDel-Resp/PDel-Resp Follow-Up messages for {s): 10
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3.9 Applying packet delays

Select the Delay row, and ensure the Delay checkbox is ticked:

Selected Message Types Intrinsic Delay
Master Tx: Sync, Del-Resp, Announce Packet size: Small Packets (< 200 bytes)
Master Rx: Del-Reg Delay (ps): 6.7
Configuration Delay General Settings
Flow Filter Mode: Type: Apply to:
(O single (®) single flow (relative) () Packet sending time
(®) Repeat (O Multi flow () Correction field
Master 1 Tx Packet rate (Packets/s): (@) Both
RS
Header Overwrite |
Physical Corruption  [] | Delay Insertion
Packet Corruption [ Fixed delay {i:): (i ]
Profile Corruption O Variable delay type:
Master Impairments ]
pa O sautnoth # of Packets:| 2000
Beating,F ~
Master 1 Rx ¥in (s | 6.00
(O step function
Delay OLateney Max fus’:| 10006.00
Header Overwrite
O Constant alpha:| 2.00000
Physical Corruption ] () Gaussian
Packet Corruption O ) Gamma Beta:| 1.00000
Profile Corruption O (®) User defined Generate
Import -
= hdin hean [LERS
Gaussian [Marmal) Distribution
Imported Profile
| Mo File Imported, |

Choose whether the delay profile should be repeated or applied only once by selecting the relevant radio button.

For most test scenarios, Single Flow (relative) is the appropriate type of delay application. This will apply each delay value
from the delay profile (see below) in turn to the incoming PTP packet stream i.e. applied delays are additive to the ingress
timing delay of the packet. Multi Flow is described in Appendix 3 of this document.

Select how the delay will be applied:

Apply to: The packet is delayed by the value read from
. ) the delay profile.
(®) Packet sending time
. Emulates a TC* by incrementing the message
() Correction field

CF* by the delay value.

() Both

Emulates a TC* by applying the delay value to
the message CF* and simultaneously delays
the packet by the same value.

*TC = transparent clock

*CF = correctionField

A Fixed Delay can be applied to all packets flowing through Paragon-X. The minimum value is dependent on the line rate
chosen in Setup Interface and the packet size selected in the Intrinsic Delay - Change dialog:

Intrinsic Delay
Packet size: Small Packets (< 200 bytes)
Delay (us): 6.7
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Instrument Intrinsic Delay >

Maximum Packet Size

() Jumbo Packets { < 12000 bytes )
Intrinsic Delay = 1002.4us at 100Mbps, 100.7ps at 1Gbps, 16ps at 10Gbps

(") Mormal Packets { < 1518 bytes )
Intrinsic Delay = 152.4ps at 100Mbps, 20.7ps at 1Gbps, Sus at 10Gbps

(®) Small Packets (< 200 bytes )
Intrinsic Delay = 32.4us at 100Mbps, 6.7ps at 1Gbps, 3ps at 10Gbps

MNOTE:

Instrument Intrinsic Delay applies to all packets.

For small and normal packet size selection, packets in excess of the selected size
will be dropped.

For jumbo packet size selection, packets in excess of 12000 bytes will not be
dropped but will have intrinsic delay areater than the indicated values.

and the maximum 2s plus the intrinsic delay e.g. 2,000,006us for the above configuration.

Different types of variable delay can be applied by clicking the appropriate radio button.

e G.8261 Sawtooth profiles (Beating Delay on faster stream or slower stream)
e Step Function

e Latency

e Constant

e Gaussian

e Gamma

e User Defined

Selecting any of these delay profiles (except User Defined) will display and allow configuration of their relevant
parameters.

Master 1 Tx
Header Overwrite O
Physical Corruption  [] | Delay Insertion
Packet Corruption O Fixed delay (us): @
Profile Corruption (] Variable delay type:
Master Inpaiments - [] O santootr # of Packets:
# :
User,F
Master 1 Rx M jen |

() Step function
Delay O Latency Max (us): | 10006.00
Header Overwrite O O Constant Mean (1) 5006.00
Physical Corruption ] @ Gaussian : |
Packet Carruption O O Gamma Std Dev (us):| 4500.00
Profile Corruption O (O User defined Eixled

ela
Impaort Y :
Min Mean Max
Gaussian (Mormal) Distribution
Imported Profile
Mo File Imported.




8. Once suitable values have been entered, the delay profile can be generated by clicking Generate  This will display
the generated packets in the usual capture window format:

. . . Dela
To return to the impairments screen, click on the Y button.

Note: the displayed correctionField values will always show as Ox0O0 in this view as the Delta delay value is used for
both packet delay and correctionField incrementing.

9. The User Defined option can be used to import for replay a .cpd, .cpw, .clxz or .csv file previously saved on a Paragon-

X. Clicking fmport 1 will open a window to allow the import of these or a user-created .csv file. A status bar will show
the progress of the import.

. fmpat or .' in the icon bar. Click to show

10. To start applying the impairment profile, click
the calculated delay profile.

Master Tx Replay
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The graph has a small red vertical bar above it which shows the progress of the delay profile replay.
Note: when in Master Clock-Slave Clock Emulation (MSE) mode, the replay will not start unless MSE is also started.

When a capture is started the captured data will displayed above the delay profile, with the progress indicator showing
progression through the profile:

DEL-RE
DEL-REQ

. Impairments
Replay can be stopped by clicking or
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3.10 Adding Impairments and Delays to IEEE1588 messages in hon-Master Clock-Slave Clock mode

Del
Select il to display the impairment configuration window. This allows configuration of various types of

packet delay and corruptions to be applied to the PTP packets flowing in both directions through Paragon-X. It is possible to

add lost/errored packets simultaneous to a delay being applied to the packets.

Add Impairments/ Delay

Instrument Intrinsic Delay
Enable Select | Intrinsic Delay for Jumbo Padkets (= 12000 bytes) is 1000.0 ps .
1588 Messages - Selected by FlowWizard
Port1:
Port2:
Corruptions Overwrite Delay
Physical Filtered Packets Frofile (5. 1050)

Port 1 Port 2

Phy/Link Corruption Type
[JEnable
Type
Symbol Errors

Link Flap

Distribution
Single Burst |1 pkts Constant
Rate (%) | 0.01000 Ratio 1 E- 4 Rate (sym/s)
Periodicity
Continuous

ONfor | 0.1 5 Repeat | 10.0 5

Start Impairments Stop Impairments

Corruption, Overwrite or Delay is applied by configuring settings after selecting the appropriate tab:

Corruptions Qverwrite Delay

Note: Impairments are applied to message types which have been selected using Flow Wizard. If no streams have been

selected, no impairments will be applied.

No streams selected: 1588 Messages - Selected by Flow\Wizard

Portl:
Port2:

Streams selected: 1588 Messages - Selected by FlowWizard

Portl:Del-Reg
Port2:5ync,Del-Resp
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Adding corruptions

1. Use the Corruptions tab to configure the applied settings:

Corruptions Overwrite Delay
Physical Filtered Packets Profile {G.1050)
Port 1 Port 2

Phy/Link Corruption Type
[Jenable
Type
Symbol Errors

Link Flap

Distribution

Single Burst 1 pkts
Rate (%) | 0.01000 Ratio |1 |E- 4
Periodicity

Continuous

Constant

Rate (sym/s) |1

QM for 0.1 g Repeat | 10.0 5

2. Select the port to which corruptions will be applied. Only one port can be enabled at any given time so ensure the

Enable checkbox is ticked for the desired port. Green ticks will be shown on the various levels to indicate corruptions
have been enabled:

Corruptions Overwrite Delan

Physical Filtered Packets

Port 1 Port 2

Phy Link Corruption Type
Enable

Type

(®) Symbol Errars

(I Link Flap

3. The type of corruption is selected by clicking the relevant radio button, and then how the corruption is to be applied can
be configured:

Distribution

() Single Oeurst | 1 sym (®) Constant

(ORate (%) | 0.01000 ORate 1 E- 4 (O Rate (symfs) | 1
Periodicity

@ Continuous

(Do for 0.1 5 Repeat | 10.0 5 —
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Using the Filtered Packets tab similarly allows the configuration of packet error types in either direction, and how they
are applied:

Physical Filtered Packets Profile {G. 1050)

Port1->Port2 Port2->Port1

Packet Corruption Type
Enable
Type
(O)Misordered Event | 1 Depth

(O Lost Packet
() Repeated Packet

(®) Errored Packet

The Profile (G.1050) tab allows packet loss as per G.1050. Low and high rate packet losses may be configured in both
port 1to port 2 and port 2 to port 1 directions simultaneously with each other and with either Filtered Packets or Physical
Corruptions.

Packet loss configured in this option will only be applied if the necessary delay profile is generated by clicking the
Generate Profile  ,\tton and the Enable checkbox is ticked:

e Enable checkbox ticked, but no profile generated, so no impairment will be applied:

Physical Filtered Packets Profile {G. 1050)

Replay Mode
(_JSingle (@) Repeat
Port1-=Port2 Port2-=Port 1

Enable () Marked packets wil be dropped
(To activate: enable 'Variable Delay Insertion' or Generate Profile)

G. 1050 {random) Packet Loss
Low Loss State (initial state)

Packet Drop Probability 0.0010000 %%
State Transition Probability | 0.0000000 %

High Loss State

Packet Drop Probability 75.0000000 %%
State Transition Probability | 85.0000000 %

Mumber of Samples | 1000

Generate Profile
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e Profile generated and Enable checkbox ticked; indicates impairment will be applied:

Physical Filtered Packets Profile (G. 1050)

Replay Made
() single (@) Repeat

Port 1-> Part 2 Part 2 - Port 1

Enable @ Marked packets will be dropped

. 1050 {random) Packet Loss
Low Loss State (initial state])

Packet Drop Probability 0.0010000 %%

State Transition Probability | 0.0000000 %
High Loss State

Packet Drop Probability 75.0000000 %

State Transition Probability | 85.0000000 %

Mumber of Samples
Generate Profile

Overwrites can be configured and enabled in the Overwrite tab. Only one direction (Port1 > Port 2 or Port 2 - Port 1)
can be enabled at a time: if one is chosen the other direction will not be available unless the first is disabled. Ethernet Il,

802.1Q and 802.1QinQ encapsulations are available, with full control over what bits are overwritten and with what data.

Add Impairments/ Delay -
Instrument Intrinsic Delay
Enable Select | Intrinsic Delay for Mormal Packets (< 1518 bytes) is 20.0 ps .
1588 Messages - Selected by FlowWizard
Portl:
Port2:
Corruptions Overwrite Delay
Portl->Port2 Port2-=Portl
[JEnable Reset All Modifications
View As Format
Link Encapsulation | Ethernet IT ~ |  Service |Raw -Bytes v 85:2:”‘" ; : Eﬂ;:ﬁtmﬂdiﬁ
o Ethernet I 1(112)  bin Exiehices ~
: [ Destination: 1(48) bin
[ Source: 7(48) bin
i Types 13(16) bin e
B Data: 15(512) bin
... byte #0: 15(8) o1 I ——
.. byte #1: 16(8)  bin
. byte #2: 17(8) oS R ——
.. byte #3: 18(8) hin
. byte #4: 19(8) bin
.. byte #5: 20(8) bin .
Distribution
single Burst |1 pkts Constant
Rate (%:) | 0.01000 Ratio 1 E- 4 Rate (sym/s) |1
Periodicity
Continuous
ONfor | 0.1 5 Repeat | 10.0 s
Start Impairments Stop Impairments

X
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i & [
5. To start applying impairments, click Start Impairments or

Stop Impairments
6. To stop the impairments click — or A

Adding bi-directional delays

B i o ite Delay
1. Click the Delay tab — Ve

2. Ensure that the appropriate message types have been selected in the Flow Filter, that the relevant Intrinsic Delay is set,

and that impairments have been enabled, then tick the Enable checkbox under the Variable Delay insertion (latency)

section to allow configuration of the delays:

Add Impairments/ Delay -

Instrument Intrinsic Delay
[+ Enable Intrinsic Delay for Normal Packets {< 1518 bytes) is 150.0 ps .

1588 Messages - Selected by FlowWizard

Portl:Del-Req
Port2:Sync,Follow-Up,Del-Resp

Corruptions Overwrite Delay
Mode Type Apply to
O single Single Flow (Relative) Packet Sending Time
(® Repeat L =
Port 1-3 Port 2 Port 2 -> Part 1

Fixed Delay Insertion {(atency)

[mo =@

Variable Delay Insertion

Eniable () sawtooth Beating,F
(C) step Function Jitter
O Latency @ Gaussian
(O Constant ) Gamma
#of Packets | 1000
Min | 150.00 ps
Max | 10150.00 | ps

Mean
5150.00 us et
StdDev | 1000.00 s Delay
[ H
Generate in Mean [E=YS
Gaussian (Mormal) Distribution
(") User Defined Import Auto Level

Drop Packets Using Captured Sequence Enable

R Rate Match
eplay Rate Ma Port Packet Rate (Packet/s)

|:| enabled rate match @ Port 1 Port2 Change

Start Impairments Stop Impairments Close

3. Configure whether the delay profile will be applied repeatedly or run once by clicking the appropriate Mode radio
button.
4. Use the Type dropdown menu to select whether the delay will be applied to a single or multiple flows (see Appendix 3

for Multiple Flow details).
5. Select how you want the delay to be applied — default is to the Packet Sending Time.

Apply to
Packet Sending Time e

Packet Sending Time
Correction Field
Packet Sending Time & Correction Field
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Applied to

Description

Packet Sending Time

The packet is delayed by the value read from the
delay profile.

Correction Field

Emulates a TC* by incrementing the message CF*
by the delay value.

Packet Sending Time & Correction Field

Emulates a TC* by applying the delay value to the
message CF* and simultaneously delays the packet
by the same value.

*TC — transparent clock

*CF — correction Field

Delay profiles can be enabled and configured independently for flows Port 1 = Port 2 and Port2 = Port 1to allow testing

of Asymmetry in the network. Each may be configured by selecting the appropriate tab. In the screenshot below, both
directions have been enabled, as indicated by the green ticks.

Port 1-> Port 2 Port 2 -> Port 1

rate, and the configurable maximum is 2s plus this intrinsic delay.

Instrurnent Intrinsic Delay

Maximum Packet Size

(") Jumbo Packets { = 12000 bytes )

(_IMormal Packets { < 1518 bytes )

(®) Small Packets { < 200 bytes)

MOTE:

will be dropped.

Intrinsic Delay = 1002.4ys at 100Mbps, 100, 7ps at 1Gbps, 16ps at 10Gbps

Intrinsic Delay = 152.4ps at 100Mbps, 20.7ps at 1Gbps, 5ps at 10Ghps

Intrinsic Delay = 32.4ps at 100Mbps, 6. 7ps at 1Gbps, 3ps at 10Gbps
Instrument Intrinsic Delay applies to all packets.

For small and normal packet size selection, packets in excess of the selected size

For jumbo packet size selection, packets in excess of 12000 bytes will not be
dropped but will have intrinsic delay greater than the indicated values.

8. Different types of delay profile may be selected by clicking the appropriate radio button O

All impaired packets flowing through Paragon-X experience a fixed delay. The minimum is dependent on the chosen line
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10.

1.

12.

Variable Delay Insertion

Enable () Sawtooth Beating,F
(") Step Function Jitter
D Latency H
D Constant D Gamma
# of Packets | 1000
Min | 150,00 us @
Max | 10150.00 us

Mean
5150.00 us Fixed
Std Dev | 1000.00 ps Delay
R mm—]
Generate hin Mean [ E=%4
Zaussian (Marmal) Distribution
(") User Defined Import Auto Level

Drop Packets Using Captured Sequence Enable

Replay Rate Match
Ry Rate e Port Packet Rate (Packet/s)

[ enabled rate match i Fort 1 Port2 Change

e G.8261 Sawtooth profiles (Beating Delay on faster stream or slower stream)
e Step Function

e Latency

e Constant

e Gaussian

e Gamma

e User Defined

Selecting any of these delay profiles (except User Defined) will display and allow configuration of their relevant

parameters.

Once suitable values have been entered, the delay profile should be generated by clicking . This will display

the generated packets in the usual capture window format in the background.

For adding the same or different delays in the other direction. Select the other direction tab and follow steps 1to 6
above. When delays are being added in both directions there will be a green tick shown in each direction tab as shown

below.

| port1-»Port2| [ Partz->Port1 |

i &
To start applying impairments, click Start Impairments or
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Appendix 1 — Using the PDV Editor

This feature allows captured timing profiles to be manipulated in a number of ways. It is intended to aid experimentation to
establish limits of operation and margin testing, and to allow network events to be combined to produce a composite profile
which will speed up testing.

The tool will operate on all profiles captured by Paragon when in IEEE 1588 or Services modes of operation.
1. From the Tools dropdown, select PDV Editor > On.

Note: PDV Editor can only be enabled when a suitable capture file is loaded in the Paragon-X GUI. This may be a recent
capture, or a previous one which has been loaded from a .cpd or .cIxz file.

Tools Help

1588 Transparent Clock Latency
= Calculate differential PDV
Split POV filles
Join C5V files
PDV Editor
File Converter

Script Recorder...
View Recorded Script

PTP Field verifier

Legaging 3

Plot PDF/CDF MHistogram
Calnex Analysis Tool {1588v2)

FOY EDITOR A

2. Edit the profile by placing the cursor on the graph display and pressing the left mouse button. This will display the menu
shown below.

Zoom in X

Remove
Repeat

Copy
Paste

Modulate
Scale
Offset

Banding

Moise Floor Density

Undo Last
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3.

a.

The editing functions that can be carried out from this menu are:

Remove — allows part of the timing profile to be cut out and disposed of or to retain part of the profile and dispose of the
rest. One use of this feature is to extract a short part of the profile to allow it to be replayed to determine if it is a stressful
section of a replay which causes a Slave Clock failure.

There are two methods of delimiting the section of interest.

The first is to use the mouse. Place the cursor at the start of the section of interest then left button down and drag the
mouse to the end of the section of interest. This will highlight the area.

Orverall b

Zoomin X

Remove
Repeat
Copy
Paste

Modulate 3
Scale »
Offset 3
Banding »
Noise Floor Density

Status: Idle

Urydln Last

The second way is to use markers. These are set using the Markers buttons shown on the screen below.

There are two methods of placing the markers; using the mouse and using the location. In each case both markers
should be set. These are marked on the graph as 1 and 2 as shown below.

0000117615
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To use the mouse, click the Markers button 1 or 2 and a menu will appear. Select Set Marker using the mouse then
place the cursor at the desired position and left click. The marker will appear as shown in the previous screen shot.

x

J To use the location, click the Markers button 1 or 2 and a menu will appear. Select Enter
Marker manually. A pop-up window will appear as shown opposite. The parameters can
then be entered.

Y-adis Position: |D.UDDD39586
s rasten Once the area of interest is selected the left mouse should be clicked and then Remove
either the Marked or Non-Marked area.
oK I Cancel |

X-axis Position: | ERNGRYRG]

If Marked is selected then only the area highlighted is removed and the rest of the profile retained.

If Non-Marked is selected then only the highlighted section is retained with the rest being removed of and the rest is
kept.

Example of highlighted area deleted from original

Original Profile Edited Profile — with section removed

Repeat — allows a section of a profile to be be repeated a controlled number of times. The whole profile may be
repeated or a section repeated within the overall profile.

There are 3 sub-selections:

ﬂ All where the overall profile is repeated the selected number of times. When the All
selection is made the pop-up screen opposite is displayed to allow the repeat number to

Repeat Count: I be set.
ITI Cancel |

The range of the repeat numberis 1to 9.

As an example, the following profile will have three additional repeats inserted as shown in the second screen shot.

Original Profile Edited Profile — with repeat count of three

The other two sub-selections allow parts of the profile to be repeated within the overall capture.

The selections allow the marking of the sections to be performed either using the mouse or using markers as introduced
in the Remove section.
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The following illustrates the repeating of partial profile three times.

Original profile with section highlighted using the mouse click and drag.

Original Profile After repeating three times

Copy and Paste — allow parts of the profile to be copied then inserted into a later part of the profile.

The modes for Copy are:
e All where the whole profile is copied
e Highlighted where the section identified by using the mouse click and drag is copied

o Marked where the two markers identify the section to be copied

The modes for Paste are shown below.

Zoom in X

Remove

Replace highlighted
Replsce bebween markers,
Insert before start
Insert after end

Modulate
Scale
Offset
Banding
Noise Floor Density

Marker 1
Marker 2

Wndo Last:

¢ Replace highlighted allows the data in the copy buffer to replace the highlighted area.

o Replace between markers allows the data in the copy buffer to replace the data between the two markers. Operation
of the markers is explained in the Remove section.

o Insert before start inserts the data in the copy buffer before the start of the data.
¢ Insert after end inserts the data in the copy buffer after the end of the currently loaded data.

¢ Insert at marker inserts the data in the copy buffer at the point marked by the appropriate marker. Operation of the
markers is explained in the Remove section.

Modulate — allows sections of the data (graph) to be edited by adding a:
e Step in amplitude

e Sawtooth increase in the values

e Triangle increase in the values

The range over which this change is applied is selectable as All, Highlighted or Marked. These are set as described in
the Remove section.
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As an illustration, the following shows how to apply a step offset to part of a profile.

Original profile with section selected using markers.

Modulation Function:
¥ Step

" Sawtooth

" Triangle

Amplitude (s): | 200]

The range of the Modulation Amplitude is 0.1 microseconds to 1 second.
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e. Scale — allows you to increase or decrease the PDV.

*
Sca J Again, the packets to be impacted are selected from All, Highlighted or Marker. The level

Scale Factor (%): I— of the scaling is set on the pop-up screen shown opposite.

The range of the scaling is 10 — 1000%
OK I Cancel |

As an example, the following will have the first part of the profile scaled to 50% of its original value.

Initial profile with the highlighted section.

Scale Factor (%) | 50l

The final result is shown below.
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f.

Banding — allows the packet timings to be gathered into bands or excluded from a band of timing.
For a clearer view of the data it is recommended that the graph be viewed in scatter graph mode rather than line mode.

The scatter graph mode is selected using the Select Graph > Graph Format > Dot controls located at the right hand side
of the graph display.

The scatter graph display for Testcase 12a 16pps is shown below.

The data in the defined band may now be depleted or concentrated.

If Deplete > All is selected, the packets in the band are moved out by adding an offset equal to the band height to each
of the packets to be moved as shown below.
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If Concentrate > All is selected, you will be prompted for a percentage. This is the percentage of all packets in the
profile that will be concentrated into the band defined by the two markers.

The packets selected to be moved into the band are picked at random and given a randomised value within the band
set. The result will be as shown below where 50% of the packets have been concentrated into the define band.

It is possible to apply the Banding over a section of the profile by highlighting the X-axis range over which the
Depletion or Concentration is required.

For example the screenshot below shows the markers defining the band to be adjusted and the highlighting to define an
X-axis section to be manipulated.
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Noise Floor Density — allows the profile to be adjusted to change the density of packets to be found in the noise floor
i.e. lucky packets.

There are two dimensions that can be defined. If only a limited section of the profile is required to be adjusted, then that
section should be highlighted using the mouse click and drag as defined in the Remove section.

The band of interest is defined between the packet with the minimum delay and one of the markers. Based on the
requested %, the number of desired packets within the noise band is then calculated.

o |f there are less packets than requested, packets out with the band are linearly selected and reassigned a new random
value in between the marker and the minimum profile value.

o |f there are more packets in the band than requested then packets within the band are linearly selected and offset by
the difference between the marker and the minimum profile value.

Example 1: If you are making an adjustment across all of the packets, you need to define the top of the band using the
marker (Marker 2 in this case). This is shown below.

The Banding and the Marker are selected as shown below. Since there is no highlighting, the only choice is All i.e.
across the whole set of packets.

Remove
Repeat
Copy
Paste

Modulate

ity

b e FT
Scale A "ﬂﬁ,f’:"‘
Offset e ‘-"""“vﬁw"

: 2
3 5 e
Banding X3 fort e"g‘*'w.f

The percentage of packets to be placed in this band is now user-selectable via the
pop-up screen.
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The following shows the effect when 80% of the packets are moved into the band.

S
et
g &Lz.;xs.‘g
o

s
b5l

=

Example 2: Where the manipulation is applied over part of the packet set using the highlighting feature.

Initial data set is shown below.

SuP sy
Sy
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Set the range of the area to be adjusted.

Apply the Noise Floor Density adjustment as described in Example 1, Noise Floor Density, Max = Marker 2,
Highlighted.

h. Undo Last — allows you to return to the data set prior to the last operation.

Note that several windows may be opened to allow cutting and pasting of parts of several profiles to provide a final
composite data set for replay. This is invoked by using the File > Import selection from the application toolbar menu.
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Appendix 2 — Raw Bytes decode of 1588 header

The raw bytes of the captured header which contains the Common Message header and the message specific fields can be
viewed in a tabular format.

Start Capture

The data is captured using the button, which will display the tabled and graphed results in the usual way:

. Paragen-X - AE Lab -0012105(192.168.207.100:9930]) Start: 2018/07/03 12:08:56  Imported File: 1588.cpd - [m] X
File Instrument Setup Capture Impair Graph Data Tools Help
EH oo &g (528 % ¢ @ [m T

Start Up

Operating Mode

Setup Inte;

Master{SlavelGPS
Emulation

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments}
Delay

Packet
Generation

Results

Status: Idle

To view a captured message in hexadecimal, left click the mouse on the table entry to highlight the desired packet, then
right click to display the following menu:

I Paragon-X - AE Lab -0012105(192.168.207.100:9990) Start: 2018/07/03 12:06:56  Imported File: 1588.cpd - 0 E'e
File Instrument Setup Capture Impsir Graph Data Toals Help
Ed oo FEEL & e m ®

Start Up

Operating Mode Goto Packet

Display Raw Packet
Setup Interface 5
Drop Packet(s)

Re-enable Selected Packet
MasterfSlavel/GPS
Emulation Revert to Original Profile

Unde Last Drop Action

Measurements

Select Flow

Configure Capture

Start Capture

Add Impairments}
Delay

Packet
Generation

Statistics{
Results

Status: Idle
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Select the Display Raw Packet menu item to display the packet data:

Raw packet data x

00 010203040506 070809 0a 0b Oc 0d Oe Of

ala]

010200 2c 18 00 00 00 00 OO0 00 OO 0D 00 00 00 |

10 | 00 00 00 00 00 00 00 OO 00 00 0D 02 00 01 09 0a |

20|01?F00005b31358ﬁ4091e929b |

® | |




Appendix 3 — Multi-flow packet delays

Single-flow packet delay mode applies the specified delay profile (either generated or user-defined from a specified file) on a
packet-by-packet basis to all packets that pass the selected filters.

Multi-flow delay insertion applies each delay value for a period defined by the user, so all packets in the multiple flows which
pass the selected filters within this period will be affected by the same delay value. Once this configured time has passed, the
next value from the profile is applied for the next period.

Both single-flow and multi-flow modes apply each packet delay relative to the inherent delay of the passing packet.

The fixed time period is specified in terms of the lowest packet rate for all the flows of interest, and is the reciprocal of the
packet rate selected by the user. This ensures that each packet in the lowest rate stream will have a delay profile value applied.

Delay General Settings
Mode: Type:
Single ) single flow (relative)
Repeat (®) Multi flow

Packet rate (Packets/fs):

256
512
1024

Note: delays will only be applied to those flows and message types which have been configured using the Flow Filter as
described in the Applying Packet Delays section.
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